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Nanotechnology, especially that involving hydraulic or fluid flows, is promising to revolutionize the field 

of medicine and scientific research. Lab on a Chip devices and DNA microarrays are promising technology for in 

vivo-like study and personalized medicine. However, in order to efficiently design these devices we need to 

llllderstand fluid dynamics at intersections at a microscopic level. Previous studies have probed the microfluidic 

characteristics of laminar flows, including the modeling of blood flow and the study of flow through converging 

channels. However, not all flow is planar, and other groups have studied the dynamics of core-arumlar flow, a 

particularly fascinating effect where one fluid is encapsulated within the other. We report the creation of robust 

microfluidic devices for core-annular flow study, allowing dynamic imaging of flows up to Re = 400. Fwthermore, 

we rigorously characterize the flow cmvature and interface profile for intersecting flows of the same viscosity over a 

wide variety of flow conditions, using modules with rectangular channels of equal size, a common geometry that is 

easy to fabricate using soft lithography techniques. The flow profiles were categorized into four flow regimes: 

planar, curved, transitional, and annular flow, and the effect on flow cmvature of changes in Reynolds nwnber, flow 

ratio (Q), channel width, and intersection angle was determined. Three modules were used: two with 90° channel 

intersections, with channel sizes of 129 ).lm X 100 ).lm and 200 ).lm X 100 ).lm, and one with a 45° channel 

intersection, with channels 161 ).lm wide by 100 ).lm tall. An increase in Reynolds nwnber was fOlllld to increase the 

interface curvature, eventually leading to annular flow. Similarly, and increase in Q was fOlllld to slightly increase 

the flow cmvature, while increasing channel width and decreasing intersection angle both drastically decreased flow 

cmvature. For the more square 90° module, annular flow was obtained at Re = 158 and above, while for the 

rectangular 90° module annular flow was not obtained lllltil Re = 274. Finally, for the module with a 45° intersection, 

annular flow was obtained at Re = 391 and beyond. The findings presented suggest that inertia plays the leading role 

in annular formation when the flows are of equal viscosity and missible, and the effect of various real-world 

parameters are carefully parsed out. While viscosity and interfacial free energy effects may dominate the flow 

patterns when they are present, this paper characterizes the inertial forces that may be otherwise missed or may 

complicate the analysis of more complex situations. 
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1. Introduction 

The project described below involves the study ofthe fluid dynamics and profiles of converging 
flows in microfluidic channels at high (>200) Reynold's numbers. To obtain these higher Reynold's 

numbers and corresponding flow rates, the flow modules used were be redesigned to have a permanent 
glass top that is chemically bonded to the module. The modules were designed to have a main channel 
that intersects a daughter channel equal in size in the middle ofthe module at varying angles (90' and 45'). 

Two 90' channels are investigated, one with cross sectional dimensions 129 X 100 fUll and the other 200 

X 100 11m. The 45'channel dimensions are 161 X 100 fUll. A confocal microscope was be used to 
measure the fluid profiles in three dimensions around the intersection ofthe channels, and these 
measurements were used to create models ofthe fluid flows. The effects of Reynolds number and flow 

ratio as well as module specific variables on flow characteristics were investigated experimentally 
through comparisons of software-processed renderings of fluid interface. 

2. Technical Discussion 

2.1 Background 

The increasing importance and promise offluid based nanotechnology for medicine and research, 
such as Lab on a Chip devices, DNA microarrays, and laboratory flow cells mandates the increased study 
and understanding ofthe physics that govern fluid flows in microscale channels l

.
2 Many ofthese devices 

involve fluid flows in converging channels and the mixing of fluids, yet our understanding offluid 
dynamics on the micro scale is limited, especially when compared to our understanding of macroscopic 

flows. In order to properly design nanotech devices such as Labs on a Chip and further research into 
hydraulic nanotechnology we must understand the dynamics of fluids on these smaller scales. 

On the macroscopic scale, core-annular flow has been studied extensively as a method for 
transporting viscous liquids with minimal frictional losses. For example, crude oil can be pumped long 

distances with relative ease by surrounding the oil with a film of a less viscous liquid, typically water. The 
practicality and peculiar dynamics ofthis phenomena has led to a great deal of interest from classical 
fluid dynamicists, who have produced a substantial body of work investigating core-annular flow on 

conventional scales 3 Microscopically, Hitt and coworkers have reported the creation of core-annular flow 
in 90' intersecting channels at Reynold's numbers as low as Re ~ 20 and flow ratios 

DDDDDDDD DDDDDDD DODD. ... 
(0 = 000000000 ) of 0.4 With a daughter channel flow that IS 4x as VISCOUS as the mam 

channel flow 4 However, the modules used in this experiment had daughter channels that were halfthe 
width and height ofthe main channel, and with the daughter flow entering from the top, a geometry which 
likely guides the daughter flow into a Core-Annular configuration and is very difficult to produce using 

conventional microfabrication techniques. 

Previous research has extensively probed the characteristics ofthese flows at low Reynolds 
numbers, i.e. in laminar, non-turbulent situations. Macken and coworkers have investigated converging 

flow situations in 100 11m x 100 fUll square channels at Reynolds numbers below 60, including 
investigations of blood-like flows at Re ~ I and studies on the convergence of flows at different 
intersections, such as channels that intersect at 90' and 45' angles at somewhat higher Reynolds numbers. 



Although Reynolds numbers tested were not able to produce a fluid interface close to a Core-Annular, the 

study clearly showed that an increased Reynolds number is associated with a greater interface curvature, 
suggesting a further increase could result in a flow of Core-Annular shape.' 

2.2 Module Fabrication 

2.2.1 Design Improvement 

The microfluidic devices used for these experiments were clear acrylic flow modules with the 
channels precision milled into the substrate, but lacked a top cover. At low flow rates, this could be 
compensated for by covering the flow module with clear tape, which sealed the channels without 

interfering with the flow. However, at higher rates offlow and Reynold's numbers, the glue on the tape 
was unable to withstand the pressures within the system and no longer sealed the channels, allowing fluid 

to leak out and making it impossible to know the flow rate or Reynold's number. Attempts to rectifY this 
by gluing a glass cover slide to the top ofthe module resulted in either an incomplete seal due to an 
inadequate amount of glue or conversely a surplus of glue filling the channels and preventing flow. To 

resolve this issue the module was redesigned to allow for the device to be sealed without glue. The new 
method of sealing the module to the glass slide was through a process similar to cold-welding, where 
chemical silicon-oxygen bonds would be formed between the glass slide and module substrate if brought 

together under a vacuum. To do this required the module to be made from a material that is chemically 
similar to glass, and so the common polymer polydimethylsiloxane (PDMS) was substituted for acrylic. 

This switch also mandated a completely different manufacturing process, using recent soft lithography 
microfabrication techniques based upon a procedure published by the lab of John Heyman.' 

The fabrication ofthe PDMS module is a multistep process, involving the design of a photomask, 
the creation of a silicon master, the fabrication ofthe PDMS module, and the bonding ofthe module and 

glass slide (Figure I). First, the desired pattern was designed using AutoCAD software and sent of to a 
photo optics company to print a photomask, a glass slide with opaque iron oxide material coated on it in 

the negative shape ofthe designed pattern (Figure 2). Next, a silicon chip is spin coated with an optically 
active material called photoresist, which crosslinks and hardens when exposed to UV light. The 
photomask is then placed on the coated silicon chip, which is then irradiated with UV light. The 

photomask reflects light where it is coated with iron oxide, and so only the uncoated areas ofthe 
photomask allow light to strike and cure the photoresist. After washing off any uncured photoresist, the 

desired pattern is left on the silicon chip, creating the silicon master for fabrication. 
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Figure 1: Diagram depicting the various steps in the fabrication of the microfluidic devices.7 

Figure 2: AutoCAD design of the photomask for the 90° modules. 

Next, the PDMS is prepared as a mixture of a commercially available base and curing agent, 
which can be poured into a dish containing the silicon master. The PDMS is then degassed and cured in 
an oven, during which crosslinking and polymerization solidifY it around the shape of the silicon master. 
After crosslinking, the PDMS can be cut and peeled off the master, rendering the bulk of the microfluidic 

module. To bind the PDMS to the glass slide, both must be immaculately cleaned through air or argon 
plasma, which cleans any organic residues off of the surfaces to atomic precision and oxidizes the 
surfaces to an SiOH functionalized surface. The glass and PDMS then have chemically comparable 
surfaces, which fom1 Silicon-Oxygen bonds when brought contact under vacuum. These bonds 



irreversibly bind the glass and PDMS together without the need for glue, allowing for the unrestricted use 

ofthe microfluidic channels. Due to time and equipment constraints, these steps were outsourced to Prof. 
Adam Melvin's lab at Louisiana State University, which specializes in the manufacture of micro fluidic 
devices. 

2.2.2 Design Constraints 

Early stage ofthe project involved discussion of possible design options and requirements for the 
flow module. Prior to choosing a manufacturer for the module fabrication, we were informed that Prof. 
Macken had used a confocal microscope owned by the college's biology department for his previous 

work. While waiting for the modules to be delivered, we consulted with the biology department on their 

guidelines for accessing the department lab and using their confocal microscope. The realistic design 
constraints determined throughout the communication were working space and weight limit on the 
microscope viewing stage, and availability ofthe equipment. 

A confocal microscope is mostly used to study biological specimen placed on a microscope slide 
typically 3 by I inches with ~ I mm thickness. The microscope stage ofthe confocal where the sample is 

mounted and held in place with clips is designed with such conventional dimensions in consideration (See 
Figure 3). However, the glass slide to which our PDMS replicas is plasma bonded is 50 X 75 mm (~3 by 

2 inches), slightly oversized and cannot be placed on the current scope stage. Professor Macken resolved 
this issue in his past research by replacing the scanning stage that is connected to a motor with a fixture 

designed and made to hold his module in place, flat on top ofthe objective without having to refabricate a 
smaller, thinner module. We decided to take a similar approach, but this time instead of disassembling the 
whole scanning stage, we considered taking out just a removable insert that is secured to the scanning 

stage with 6 small hex screws. This eliminates a step in the experimental setup that could potentially 
disturb the micro-computer's motor calibration. 

Another important restriction we noted relied on key aspects intrinsic to the equipment setup. The 
equipment in use is a Leica DM6000, an "inverted" version of a typical confocal microscope such that the 

lasers illuminating the sample are in housed above the stage. This setup increases the work space above 
our sample in comparison to a traditional upright scope where the objectives are in the way. However, the 

motorized stage is bulky and thus reduces the workable space above the sample and below the transmitted 
light illuminator arm. There also exists a maximum working distance on the scope that is determined by 
the thickness ofthe sample on the glass slide, the objective being used and actual distance between the 

objective and the light collector. The issue was addressed by ensuring that our module was long enough 
so that the inlet and outlet ports 

This issue was addressed to discuss ways to which we could orient the module and achieve fluid 
delivery port connections without interfering the beam path. We contacted the biology department again 

for feasibility and safety of our ideas and were approved to proceed with taking measurements needed for 
designing and constructing an aluminum steel fixture with J's assistance as shown in Figure 3. The final 

product was also fine tuned to meet the weight requirement on the motorized stage of under 180 grams. 

Additionally, the availability ofthe equipment for use affected the project timeline. The biology 

department's lab is a campus resource that is open to students not only during course lab periods, but also 



to faculties, staffs and other students who are conducting researches that require the use of either the 
confocal itself or any microscopes equipped in the lab. The biology department has a policy for the 
confocal microscope and sharing the lab space that requests users to sign-up prior to accessing the lab 

through a Web calendar that shows available time slots. Before we commenced actual testing with our 
device, we also had confocal training sessions provided by Christina Cota in the biology department, 
walking through safety guidelines as well as the workings of the confocal and technical aspects of the 

software used for collecting data. 

Figure 3: Original confocal stage setup (top), aluminum steel fixture (bottom left), fixture inserted in the 
motorized stage (bottom right) 

3. Experimental Methods 

3.1 Solution Preparation 

Attaching different fluorophores to each channel flow makes selection and observation of specific 
parts of the module possible. The fluids for the channels were prepared by dissolving fluorescent dyes in 
water, and the channels contained different dyes that have been selected to have easily distinguishable 
emission spectra. The two dyes used are fluorescein and resorufin. The peak excitation wavelengths are 
490 and 596 nm and the peak emission wavelengths are 525 and 615 nm respectively. When excited, the 
fluorescein glows a bright green and the resorufin a pink. 



3.2 Experimental Setup 

The experimental setup consists of the flow module, delivery system and syringe pumps. (See Figure 
4) The delivery system consists of plumbing and attached syringes. Hypodermic needles are a bent at 
right angles and puncture the module at inlet and outlet ports. Polystyrene tubing is attached to the 
needles using Luer and flangeless fittings. Becton-Dickinson plastic syringes are used to store and 
dispense fluid. A tube assembly and syringe containing solution with dye is attached to each channel inlet. 
A drainage tube assembly with an Erlenmeyer flask attached is fitted to the exit of the flow module. The 
flow in each syringe is controlled by a Cole-Parmer 74900 series syringe pump. Typical flows are in the 
micro to milliliter per minute range. 

Figure 4: Experimental setup showing flow module (top), 
syringe pumps and delivery tubing (bottom) 

3.2 Confocal Microscopy 
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Figure 5: Simplified Schematic of the Confocal Microscope.5 



Flows were visualized through the use of a confocal microscope. A laser scanning confocal 
microscopy uses the principle of fluorescence excitation and emission to investigate a sample with 
various structural components. For a given fluorophore, a laser tuned to the corresponding excitation 
wavelength (blue) is brought into focus in the specimen or the flow module in our case by the objective 
lens. (See Figure 5) When excited, the fluorescent molecules emit lower energy, longer wavelength light 
(green) that passes through dichroic mirror. The emitted light is then focused onto a pinhole, passes 
through it and is measured by a photomultiplier tube. The resulting electrical output is digitized and sent 
to the computer. 

A two-dimensional image (slice) is obtained at a fixed depth perpendicular to the point of view. 
This is accomplished by XY scanning mirrors which are mounted on motors that vibrate in x- and y
dimension. They take the laser light and raster scan across the sample, thus changing the position of focal 
point at a fixed focal plane. By having a confocal pinhole screen, the microscope blocks out of focus 
fluorescent light in the focal plane, but not at the focal point. Once all pixel information for a given focal 
plane is collected by the photomultiplier detector, the scope utilizes a computer-controlled stepping motor 
z-stage to move to a different depth and acquire image sequentially. The motor coordinates step-by-step 
changes in the fine focus of scope by predetermined increments. This allows for a selection ofthin section 
ofthe flow module which is much thicker than a conventional microscope stage specimen. Here, the 
aperture between the lens and PMT again rejects out of focus light from a different focal plane and 
produces sharply focused images with better vertical resolution. 

The final output is a composite file (z-stack) that is all z-scans the scope takes to get the entire 
depth, projected onto each other. A rendering ofthe data produces a three-dimensional image. The system 
and software allow the user to carefully specifY how images are to be taken. Major adjustments include 
laser focus, power and wavelength range, scanning speed, pixel count and number of scans per slice. The 
number of slices and distance between slices is also set by the user. Our particular confocal microscope is 
an inverted Leica DM6000. 

3.3 Experimental Procedure and Data Analysis 

Once the module was fabricated the flow testing commenced. The microscope was calibrated to 
separate the emission from each dye into different viewing channels, allowing for the characterization of 

the mixing from each channel. The confocal microscope itself uses a series oflenses in combination with 
a pinhole to minimize the viewing window vertically and horizontally, allowing for the increased 
resolution of 2-D optical micrographs and the construction of 3-D structures through the layering of 
successive 2-D z-slices7 After scanning through the entire height ofthe sample, the images were 
reconstructed to create a 3-D model ofthe fluid flow around the junction ofthe channel. 

The confocal software displays the data on the computer monitor as a slice during the setup stage 
for each run. A run is defined as a set of slice for a fixed flow ratio, i.e., each syringe pump is set to a 
particular flow in the main and daughter channel respectively. The flow ratio, Q, is defined as the flow in 
the daughter channel divided by the total flow (flow in the daughter channel plus flow entering the main 
channel). Steady flow must be observed before microscope adjustments can be implemented. Once the 
setup is complete, slices are scanned sequentially for the entire depth ofthe channel, with 35 slices across 
the channel depth, each an average oftwo scans. This family of slices for a set flow is stored in a file and 
the flow is adjusted for the next run. Adjustments of microscope settings after the first run are 
unnecessary. A complete set of runs includes all flow ratios possible from minimal to maximum. The 
total flow (daughter plus main) is held constant. The scanning procedure must be repeated for each 
wavelength setting (red and green). 



Slice analysis and volume reconstruction is completed offline. Image analysis is completed using 
ImageJ software, which allows for the conversion of the proprietary file type outputted from the 
microscope. The images for each run are adjusted so that the two channels have equal brightness, then the 
channels are merged to produce a color image stack. These can be analyzed without further modification 
as 2-D still images in various X -Y planes (Figure 6), or can be compiled into a 3-D construction (Figure 
7). For easy analysis, this 3-D shape is then reduced to a 2-D vertical slice, helping to clearly display the 
flow pattern and compare it to other flow rates. To ensure that the flow is fully developed, all vertical 
slices are taken at distances equivalent to 7 - lOx the channel diameter (Figure 8). The figures presented 
in the Result section of this report are based upon these vertical slices and not the horizontal slices that the 
raw data came as. In all images, the daughter flow (pink dye) comes in from the left, forcing the mother 
flow (green dye) to the largely to the left side of the channel. 

Figure 6: Still image depicting the flow at the middle of a channel in the low-flow planar segregated 
regIOn. 

Figure 7: 3-D Rendering of Annular Flow Data in the 90° Square Module, with Re = 171 and Q = 0.65. 



Figure 8: Vertical slice downstream of the flow junction 

4. Results and Discussion 

4.1 Nomenclature 

Three different modules are investigated in this study: two with 90° channel intersections and one 
with a 45° channel intersection, all with differing channel sizes. The first module, with channels of 129 

!lm X 100 !lm and a 90° intersection, is dubbed the Square module despite its slightly rectangular 
channels in order to clearly distinguish it from the other 90° module. This second 90° module, with 
channels of200 !lm X 100 !lm, is referred to as the Rectangular module. The final module has a 45° 

channel intersection geometry and channels of 161 !lm X 100 !lm. 

The observed flow profiles are categorized into four regimes in order to simplify analysis: Planar 
flow, Curved flow, Transitional flow, and Annular flow, as shown in Figure 9a-d, respectively. Note that 

each rendering (a-d) is for the same module and flow ratio (Q) but at distinctly different Reynolds number 

(Re). Planar flow is a stratified flow pattern with a linear or nearly linear interface between the flows , and 
was observed at the lowest Re values. As the Reynolds number increases, the interface begins to bend 

around the daughter flow, creating the Curved flow regime. This region is fairly broad in definition, 
ranging from moderate parabolic bends in the interface to long U-shaped curves, as seen in Fig. 5b. When 

the interface began to curve down along the right side of the channel into a C-shape it was defined as 

Transitional flow. The Annular regime was reserved for when the daughter channel was completely 
enclosed by the mother flow, and green dye was seen on all sides of the pink core . Some examples may 

appear Transitional at first glance, such as Figure 9c, however close inspection and investigation of 

individually dyed flows reveals these to be undeniably core. 



Figure 9: Regimes for the 90° Square Module, all with Q=0.7. 

a) Planar, Re = 6.6. b) Curved, Re = 82. c) Transitional, Re = 131. d) Annular, Re = 158. 

Figures 10 and 11 compare the shape of Curved flow and Annular flow in these different modules at 
constant Q values. Note Re is distinctly different for each rending (a-c). Additionally, these figures are to 
scale and show the geometrical shape of the channel cross section in each module looking axially back 
towards the main inlet. The square channel is close to square channel and the rectangular channel is 
definitely a rectangle. The 45 degree channel is in between. 



Figure 10: Curved Flow in Different Modules, Q = 0.5 Figure 11 : Annular Flow in Different Modules, Q = 0. 7. 
a) 90' Square Module, Re = 99. a) 90' Square Module, Re = 158. 

b) 90' Rectangular Module, Re = 164. b) 90' Rectangular Module, Re = 274. 
c) 45' Module, Re = 244. c) 45' Module, Re = 391 . 

Planar flow, Curved flow, Transitional flow, and Annular flow is obtained for all channels, 
although under significantly different conditions. Four main factors are found to affect the flow pattern: 
Reynolds number, flow ratio (Q), channel geometry, and intersection geometry. The former two variables 
could are properties ofthe fluid flows and can be varied within each module, while the latter two are 
module specific and can only be compared through aggregated module data. Overall, these results 
indicate that the inertia ofthe daughter channel flow, both independently and relative to that of the mother 
channel, is the leading factor in determining the flow profile and transitions between flow regimes. 

4.2 Re vs. Q Effect 

The total flow rate in the module, encapsulated by the dimensionless Reynolds number (based off 
of the hydraulic diameter of the channel) is one of the easiest parameters to vary. The effect of Reynolds 
number on the flow is isolated and displayed in Figure 9 (a-d). By increasing the Reynolds number, the 
fluid in both channels gains increased inertia and resists changes in direction of flow. 

As shown in Figure 12, the Reynolds number is the primary indicator of flow profile, and all 
regimes appear to have a minimum Re value, below which flow of that type is not obtainable. The lowest 
Reynolds number value for which Annular flow is obtained is at Re = 138 in the Square 90° module. As 
the flow rate increased Annular flow became easier to obtain and was observed in less favorable 
conditions. While Harris and Hitt [4] found that Annular flow would become chaotic and break down at 
higher Reynolds numbers, only the lower bound for Annular flow is probed in this study. 
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Figure 12: Flow Regimes for the Square 90° Module 
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Figure 13: Flow Regimes for the 90° Rectangular Module 

While the flow ratio is not an absolute predictor of flow type, the boundary behveen flow regimes 
decreases in Reynolds number as Q increases for all but the lowest flow rates. As Q is defined for 
constant total flow (i. e. Re), an increase in Q indicates an increase in daughter flow and a corresponding 
decrease in mother flow. While the total Reynolds number remains constant, the daughter flow increases 
in speed and therefore in Reynolds number, and has higher inertia relative to the mother flow. This allows 
the daughter flow to further push into the left side of the channel and force the mother fluid into the 
corners and edges of the channel, moving towards an Annular profile. The dependence of flow pattern on 
Q is best displayed in Figure 13. While increasing Q in general increased the curvature of the intersection, 
Q values above 0.75 tend to overwhelm the mother flow and produce patterns where the daughter flow 



begins to stick to the far (left) wall of the charmel. In order to avoid this result, flow ratios are restricted to 
below Q = 0.75. Furthermore, the dependence on Q increases as the flow ratio approached Q = 0.5, where 
the equality of inertial forces between the two chatmels makes Armular flow much more difficult to 
achieve. Ideal conditions for prcxlucing Armular flow occur "With Q between 0.65 and 0.7 for all mcxlules 
(See Figure 15). 
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Figure 15: Core-Armular Flow Regimes for all Modules 

4.3 Channel Geometry 

The three modules in this study all differ in charmel "Width, ranging from a minimum of 128 J.Ull to 
a maximum of 200 ).l.1Il, although the charmel height remains approximately constant at 100 J.Ull for all 



modules. In order to isolate the effect of channel geometry, only the 90° modules are considered in this 
section. 
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Figure 16: Comparison of 90° Square and Rectangular modules 

Annular flow is obtained in both the Square module and the Rectangular module, although 
Annular flow is not observed in the Rectangular module until the Reynolds number is nearly doubled. 
The lowest values to obtain Annular flow with square channel geometries was found to be Re ~ 138 and 
Q ~ 0.675 or Q ~ 0.7, while the Retangular module first exhibits Annular flow at Re ~ 246 and Q ~ 0.7 or 
0.75, even when the Reynolds number is corrected for the change in channel geometry and hydraulic 
diameter (See Figure 16). A similar pattern is seen for the boundary between Curved and Transitional 
flow, as can be seen when comparing Figures 12 and 13. 

This effect is likely due to two related effects: first, the distance from the near edge of the channel 
(that is, closer to the daughter inlet) and the far edge has been increased, and so the daughter channel 
requires more inertia in order to force its way into the center of the channel, and therefore the Reynolds 
number must be higher. Secondly, the rectangular shape of the channel no longer allows the daughter 
flow to form a circular core shape, and forces it into the shape of an ellipse. This naturally elongates the 
intersection between the flows, making the configuration less favorable and requiring higher flow to 
produce the Annular flow pattern. 

4.4 Intersection Geometry 

The effect of the angle of the intersection between the two channels on flow patterns is probed by 
comparing the flow in a module with a 45° channel intersection with the 90° modules. The 45° module has 
channel dimensions of 161 !lm X 100 !lm, and so the results are not directly comparable to either the 90° 
Square or 90° Rectangular modules, as they have channels that are 1.24x smaller and larger, respectively. 
However, if the intersection geometry has minimal effect, the 45° module should exhibit regime 
boundaries in between those of the 90° Square and Rectangular modules. This is not the case: The lowest 
Reynolds number where Annular flow is obtained in the 45° module is at Re ~ 376 and Q ~ 0.72 (See 
Figure 17 Right), which is more than 1.5x larger than the lowest similar value for the Rectangular module 
and nearly 3x larger than that of the Square module. Given that all other conditions are comparable, the 
intersection geometry must have a large effect on the observed flow regions. The boundary between 
Curved flow and Transitional flow displays the same pattern, occurring at significantly higher Reynolds 
number values than in either of the 90° modules. 



This effect can also be attributed to the inertia of the flow. As shown in Figure 17 Left, the 45° 
daughter channel, traveling partially in the same direction as the mother channel, experiences a lower 
change in inertia as the channels intersect and has less momentum to carry if off of the nearby wall than 
the 90° modules. In order to achieve the higher flow regimes, the inertia (i.e. Reynolds number) must be 
increased much beyond that necessary for the 90° modules, since all the inertia of the daughter flow is 
used to push the fluid away from the right channel wall. Since the inertia of the 45° flow perpendicular to 
the main channel is half that of a 90° channel under comparable conditions, the boundary Reynolds 
number for Annular flow in the 45° module should be roughly twice that of a 90° module with the same 
channel dimensions. If the effect of channel geometry on regime boundary is approximated as a linear 
effect, the boundary for Annular flow in this hypothetical 161 J.lm X 100 J.lm 90° channel would be at Re 
~ 188. If the assumption of a linear relationship between Re and inertia holds, this would correctly predict 
the lower edge of the Annular regime boundary for the 45° module to be at Re = 188·2 = 376, although 
this calculation ignores the effects of flow ratio. 

4.5 Summary 

Annular Flow Regimes for all Modules 

~ Re= 138 
100L-~------~----~------~----~---

0.55 0.6 0.65 
Q 

Figure 17: Comparison of 90° Square and 45° modules 

0.7 0.75 

Overall, the effects presented in the paper are largely inertia based. Reynolds number changes 

directly alter the inertia of the flow, as the Reynolds number is defined as the ratio of inertial forces to 

viscous forces in the fluid. Q has a similar effect, and when Q is increased the velocity (and therefore Re) 

in the daughter channel is increased, directly leading to an increase in momentum at the expense of the 

momentum in the mother channel. The intersection geometry directly alters the amount of momentum in 

the direction of the main flow and therefore the forces exerted at the intersection of the flows. Only the 

channel shape has effects that aren't entirely inertia related, as the rectangular channel shapes force the 

core flow into oblong and elliptical geometries, increasing the interfacial area and making annular flow 

less favorable. While the fluids studied here all had equal viscosities, if the fluids were chemically distinct 

the increase in interfacial energy would likely add another layer of effects. While previous studies have 

shown that increased viscosity and decreased missiblity of fluids facilitates the transition to annular flow, 

the irregular channel geometries, such as seen in our rectangular module, would likely create fluid flow 

with much higher interfacial energies and would severely decrease the favorability of elliptical core 



annular flow. While we have parsed out the purely inertia effects between identical fluids, these 

interfacial and viscous effects remain topics of further study. 

6. Conclusion 

The fabrication and testing of microfluidic modules up to Reynold's numbers of 400 and beyond 

has been reported. Furthermore, the flow regimes and interfacial geometry have been characterized for a 
wide range of Reynolds numbers, from planar flow up to the annular boundary. Three modules were 

studied, allowing for the probing ofthe effects of Reynolds number and flow ratio on the flow profiles in 
modules of differing channel width and intersection angle. In all modules, an increase in Reynolds 

number led to increased curvature of the interface and eventually to the enclosure of the daughter flow 
into a core-annular geometry. Furthermore, an increase in flow ratio (Q) also increased the curvature 
slightly, although this effect was much smaller than the effect ofthe Reynolds number. Both ofthese 

trends have been shown to have a direct relationship with the relative inertias of each flows, and can be 
explained by considering the change in momentum at the channel intersection. 

By comparing aggregated data across the three modules studied two other phenomena can be 
observed. An increase in channel width resulted in decreased curvature ofthe interface and a higher Re 

necessary to create annular flow, likely due to both the need for increased inertia for the daughter channel 
to reach the far end ofthe channel and the higher interfacial area due to the unfavorable rectangular 
geometry. Furthermore, the reduction in intersection angle from 90' to 45' also reduced the interface 

curvature, which can be explained by the reduction in inertia orthogonal to the main direction of flow and 
subsequent decrease in momentum change and forces experience as the channels merge. For the square 
90' module, annular flow was observed at a minimum ofRe ~ 138, while for the 90' rectangular module 
and 45' module annular flow wasn't obtained until Re ~ 243 and Re ~ 376, respectively. 

The results presented here thoroughly characterize the complex laminar flow profiles in 
rectangular microfluidic channels of equal size and area. While other studies have reported obtaining 

annular flow at much lower flow rates, our channel geometries represent those that are much easier to 
fabricate using conventual soft lithography techniques, and therefore are more frequently used by the 

scientific community. Furthermore, while our focus on fluids of equal viscosity is somewhat restrictive in 
application, it allowed us to definitively characterize the effects of fluid inertia and separate these effects 
from those of interfacial energy and viscosity that are present in other studies. We hope that our findings 

will help to further the understanding ofthe effect of fluid inertia on complex laminar flow profiles and 
the impact ofthe individual forces on the aggregate fluid dynamics encountered in real world situations. 
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9. Appendices 

A. Dye Preparation: 

The Fluorescein (FITC) dye dissolves readily, and little more is needed to be done than drop a 
few crystals Into water and shake a few times. The Fluorescem dye is extremely bnght, so try to avoid 
putti ng too many crystals in and making the dye extraordinarily bright 

The Resorufin dye IS much less soluble. We used a double filtration method to get this to dissolve. 
A th~e piece filtration funnel was used, with one glass microfiber filter placed in the traditional position 
on top of the porous insert and clamped down, and one smalle r filter placed in the funnel below, and held 
in place only by the weight of the water (see the photo below) . Several crystal s we~ placed in the top 
sec tion, with water poured over it and left to slowly drain down. The dye has two distinct colors a cloudy 
burnt ~d and a transparent bright pmk. The burnt red color is largely filtered out by the second filter 
Sometimes it is helpful to cru sh these crystals to extract more dye, but If too many are crushed the 
solution maintains the strong burnt red color and Im'tusabl e. This IS a very finicky process, and our dyes 
varied quite a bit in strength from day to day 

____ 1 ~ Filter 

____ 2"" Filter 

Figure A 1 Photo of the filtrahon setup for the cr eatIOn of the Resorufin dye 

B. Conrocm Semp : 

The stage removal is fairly easy, just remove the 6 hex scr ews and slide the other stage in. The 
only odd part about this is the hex scr ew is a small metric Size 



The microscopy settings are loaded into the microscope under "Macken 2018." We measured each 

dye separately, averaging 2 scans per xy-slice, and then through a total of35 z-slices. The Resorufin dye 
is much darker than the Fluorescein, so we had to tum up the laser to 40 or 50% power instead of 20-30%. 
We always used the lowest power lOx objective. 

C. Image Analysis: Fiji (ImageJ) 

Fiji can directly import the files from the microscope. Just tell the program to open the file, click 
"OK" on the first window that pops up, then select all the data points you want to open (usually this is all 

ofthem). They will all pop up as individual movies, with green and pink channels separate. 

We first adjusted the brightness of each movie to roughly normalize them. Go to Image -> Adjust

> Brightness/Contrast. Then click on the movie you want to adjust, hit "Auto" on the B&C window, and 

if it looks good click "Apply" and then" Yes" in the window that pop up. We did this for both the green 

and pink movies. 

Next, we need to merge the images. Go to Image -> Color -> Merge Channels. Select the two 
movies that you want, the green move in the "C2 (green)" drop down box and the pink movie in the "C6 

(magenta)" dropdown box, although the choice of box does not seem to matter. Then click "OK. " A new 

composite movie will pop up with two bars at the bottom. To convert this back to a normal movie, go to 
Image -> Type -> RGB Color and click "OK" in the dialog box that pop up. The movie that now appears 

is in a format we can analyze and save. 

To add a scale bar, go to Analyze -> Tools -> Scale Bar ... . In the dialog box that appears set the 
desired width ofthe scale bar in the "Width in microns" box to I 00 and then adjust the location by 
selecting a choice from the "Location" drop down menu. Make sure to check "Label all slices" before 

clicking "OK. " 

To add a label to the plot, click the box with the capital letter "A" in the toolbar, right beneath the 
Analyze menu. Draw a box on your image in the location you want your label, and then type your label. 
Before clicking anything else, you must go to Edit -> Draw and then click" Yes" to save this label, 

otherwise it will automatically be deleted when you click elsewhere on the movie. This is permanent, so 
be careful to not have any typos or you will have to re-import the data and start over from a fresh movie. 

To take a still image from a frame ofthe movie, we found it simplest to merely take a screenshot 
ofthe frame we wanted. To save GIF files, go to File -> Save As -> Gif ... 

3D reconstructions were created by going to Plugins -> 3D Viewer. In the dialog box that pops up, 
set the Resampling Factor to I instead of2, and then click "OK." The 3D image will then appear, and can 

be dragged around with a mouse or with the arrow keys. The grid lines will go away if you click on the 
image. To get an image ofthis, it was easiest for us to simply screenshot the view we wanted, using 

snipping tool or something similar. Note that the scale bar and text added previously will appear as white 
columns, so if you care about the areas around these you should take any 3D images before adding those 

labels. 



The vertical slices were obtained by using the plugin Volume Viewer. Go to Plugins -> Volume 
Viewer all the way at the bottom of the menu, and a new window will pop up showing the slice. On the 

left side, a view of the volume in the xy, yz, and xz planes can be seen. On the right the transfer function 
is displayed, which can be hidden by clicking the "Hide TF" button. For the first time you may need to 

rotate the slice, using the "Rotation" boxes at the bottom of the screen. Rotate the image so that the X is 

90° and y and z are 0° (or so that the blue line in the image at the upper left hand comer is perpendicular 
to the channel). The location of the cut can be altered with the sliding bar on the upper right hand side, 

labeled "Distance." For this, we usually took a slice near the end of the channel, but tried to find a slice 
with as little noise as possible, as some are much noisier than others. To increase the size of the slice, 

merely alter the "Scale" bar on the bottom right hand side. Once again, screenshotting the slice was the 

easiest way to capture this image. We used Trilinear interpolation for all of our slices, but this can be 
changed by using the "Interpolation:" drop down box at the top of the window to reduce noise or 

blurriness. Note that the white labels and scale bar will also appear in this, but are usually far enough 

away from the areas concerned that they don't matter. 

D. Photomask: CAD Drawing 

AutoCAD software was used to create a design for the photomask. Figure D 1 is a screenshot of 
the CAD drawing file. Two sets of intersecting microchannels are drawn inside a 4" circle that represents 

the 4" Silicon wafer on which the photomask is placed. The design for a single module is enclosed with 

rectangular outline which serves as a trace for cutting the photomask later for the fabrication of a single 
module. Each module design has a main and a daughter channel with width of 100 micron, intersecting 

either at 90 or 45 degrees and inlet and outlet ports with outer diameter of 1 mm. 

Figure D 1: CAD Drawing for Photomask 

The outside manufacturer we used for photomask fabrication is CADI Art Services. The mask 

pattern in a single CAD drawing file is sent by email atcas@outputcitv.com. The design is then checked 
by a representative and edited to meet the company's manufacturing requirements. The company then 

provides a quote with a proof, which is a translation or converted version of the original drawing to a file 



that is in a workable format for the laser used to print the photomask (See Figure D2). Black and white 
binary colors represent the polarity or tone of the polygons. The closed polygons in white are our 
microstructures. They are clear and transparent to UV light while the dark areas are opaque to the light 
and does not cross-link the underlying polymer for a negative photoresist. We requested for an emulsion 
up, iron-oxide mask and the entire mask material used is 8 x 10 inches. 

Figure D2: Proof of Photomask 

E. Module Fabrication Specifications: 

The thickness of the PDMS can be adjusted based on design needs. During our communication 
with Professor Adam Melvin, we learned that approximately 17.5 grams ofPDMS is used per wafer (3" 
diameter) for general applications. Such can produce devices ~2 - 3 mm thick. The PDMS can also be 
made thicker for stability purposes which would add another 2 - 4 mm. For our device, we decided to 
make the PDMS be slightly thicker than conventional designs to give a higher elastic modulus that will 
withstand the pressures we intend to introduce in the module. 

The final product has a total thickness of ~ 7mm with a 6mm PDMS bonded to a standard 
microscope glass slide ~ 1 mm thick. The inlets and outlet ports were punctured with an 18 gauge needle in 
the lab at Louisiana State University. We provided the lab with 450 g ofPDMS, which were used to make 
8 more replicas in addition to the first 3 modules we initially ordered for each geometry. 
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